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About this Document

1 About this Document

This user manual provides an overview of the necessary operation steps and settings on the prod-

uct.

1.1 Significance of the user manual

This user manual is an integral component of the product and part of the product's safety

concept.

P Make sure that all persons who work with the product have fully read and also
understood this user manual.
P> Observe all instructions exactly, especially the safety instructions.

This user manual contains important information on safely and properly operating the

product.

P> Keep this user manual in the immediate vicinity of the product so personnel have access

to it at all times.

P> Pass this user manual on to every user, e.g., by lending it, or to the future owner of the product.
P> If this user manual is lost or damaged, a copy of it can be downloaded from the Neutrik's
website (www.neutrik.com).

1.2 Designations

Explanation

DPRO Adapter

Dante™ audio
networking

PoE
Peripheral devices

Audio source
Audio sink

DPRO Adapter NA2-I0-DPRO; to ensure the text is easy-to-read, the
device is hereinafter referred to as DPRO Adapter.

Dante™ audio networking (hereinafter referred to as Dante™) Dante™
stands for Digital Audio Network Through Ethernet and is an audio
network protocol developed by the Australian company Audinate. Dante™
delivers uncompressed, multi-channel, low-latency digital audio over a
standard Ethernet network using Layer 3 IP packets.

Power over Ethernet; the device is supplied with power via the network
connection.

Any device that can be connected to the DPRO Adapter: audio sources
(transmitters) and audio sinks (receivers)

Any device that emit an audio signal

Any device that receives audio signals, such as loudspeakers, audio
systems (amplifiers, mixing consoles, etc.)
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About this Document

1.3 Explanation of symbols

Uniform safety instructions, symbols, terms and abbreviations were used to make this user manual
easier to understand. The following symbols designate instructions that are not relevant to safety,
but make the operating manual easier to understand.

& The preconditions for an action are depicted with this symbol. Complete the items as listed be-
fore carrying out the action steps that follow.

P Action steps are designated by this symbol. Carry out the action steps in the order they are
presented.

+ The result of the action or the reaction of the product to the action are depicted with this
symbol.

e Lists without a mandatory sequence are presented as a list with this bullet.

1. Numbered listings are displayed in this manner.

(1) Refers to a position in an illustration.

Wherever you see this symbol, you will find useful information for safe, trouble-free opera-
tion of the product.

1.3.1 Symbols in illustrations

Symbol Explanation

n Image position
1 Action steps numbered in an illustration.
Carry out the action steps in the order they are presented.
¢ Only carry out these tasks when using OS X.
-] Only carry out these tasks when using Windows.
1.4 Target group

This user manual is intended for sound engineers and professional personnel who have detailed
experience in sound and event technology.
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Safety

2 Safety

2.1 Warning information and signal words

Special warning information regarding potential dangers inherent in a particular action are present-
ed before instructions for an action. The warnings are ranked as follows:

A CAUTION

Potential risk of danger!

This type of warning points out a situation that could result in minor or moderate injuries.

» Minor injuries may result if this warning is ignored.

A NOTE

Potential risk of property damage!

This type of warning points out a situation that could result in damage to the device and its
components.

P> Property damage may result if the warning is ignored.

2.2 Warning symbols

symbol \warning

General warning
Warning of hearing impairment

2.3 Important regulatory notes
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and may
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful inter-
ference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by attempting one or more of the
following measures:

» Reposition or relocate the receiving antenna.

¢ Increase the distance between the equipment and receiver.

e Connect the equipment to an outlet on a circuit different from to the one that the

receiver is connected to.

e Consult the dealer or an experienced radio/TV technician for help.

A NOTE

Changes or modifications made to this equipment not expressly approved by Neutrik may void
the FCC authorization to operate this equipment.
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Safety

2.3.1 Declaration of conformity

The device meets all the relevant EU directives and therefore has the CE and EAC marking. The
Declaration of Conformity may be viewed at www.neutrik.com/en/approvals-and-certificates.

2.4 Important safety instructions

Avoid property damage to the DPRO Adapter due to unsuitable operating and environmental con-

ditions:

* Never immerse in water.

¢ Protect from strong sunlight.

* Never install the device near heat sources such as radiators, heating units, ovens or
stoves.

* To avoid overheating, never cover the device.

 Protect the device from impact and above all, from falling from poles, stages, tables or
furniture.

Repair

Property damage due to improper repair!

The DPRO Adapter does not contain any parts that you can repair yourself. Opening or repairing
the devices on your own may result in severe damage to the device.

P Do not open the housing of the DPRO Adapter under any circumstances.

P Do not change any parts yourself.

P Only have the DPRO Adapter repaired by a authorized specialist dealer.

Information for operation

P> Ensure that the ambient conditions specified for the DPRO Adapter are observed during
operation.

P Do not use the DPRO Adapter if it is not functioning properly, has fallen or been damaged, has
become wet or if parts of it have been immersed in water.

» If disruptions occur during operation:
Immediately disconnect the DPRO Adapter from audio sources and/or audio sinks.

» Do not operate the DPRO Adapter in environments where flammable or explosive materials,
gases or vapors are present or might occur.

2.5 Intended use

The DPRO Adapter is designed for converting the signal of an analog LINE/MIC or digital AES/EBU
audio signal into a Dante™ signal. Dante™ signals can also be converted into analog LINE signals.

2.6 Foreseeable improper use

The DPRO Adapter is not suitable for use outdoors and in potentially explosive atmospheres.
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Components and Accessories

3 Components and Accessories

The device and the accessories can be ordered separately.

( cH2 A
o1 ANA pric/LIn®

mm

DPRO Adapter (device) NA2-10-DPRO

2 Mounting brackets NA-MB-KIT
(Kit includes 2 brackets, 2 fixing screws, 2 torx screws and 2 spacers)

3 Rack panel NRP1RU-2A
Removable rubber protection NA-RC

5 Trussmount kit (Kit includes 4 cross screws, 4 fixing screws, 2 safety frames, 1 yoke mount) NA-TM-KIT
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Description of the Product

4 Description of the Product

4.1 What is the DPRO Adapter?

The DPRO Adapter is a 2IN, 20UT breakout box designed to connect legacy audio equipment to
the Dante network. It features high-quality microphone preamps and 2 Dante ports for either re-
dundant setup or daisy chaining. Audio parameters are adjusted by the DPRO Controller app.

All the connectors are lockable and, together with the removable rubber protector, offer a reliable

solution for tough stage conditions. With optional mounting brackets or a rack panel, the box can
be mounted below tables, in floor boxes, racks or on the truss.

4.2 Device

Pos. | Description

1 Sheet metal housing
2 Rubber protection (removable)

4.3 Connections and displays

4.3.1 Overview front
e .

H

°
p

NEUTRIK

CH1 ANA

CH2 ANA/AES
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Description of the Product

1 Signal Present LED
Indicates the signal status.
e LED lights up green/yellow/red: signal
available, color indicates the signal level,
see section "Meter bar" on page 15.
e LED off: no signal.

2 Phantom power 48V LED
Indicates, if Phantom power is active.
 LED lights up red: Phantom power active.
e LED off: Phantom power not active.

3 HPF/Pad LED
Indicates, if HPF or Pad is active.
e LED lights up red: Pad
e LED lights up green: HPF
e LED flashs green and red: Pad and HPF
active.

4 Output MUTE LED
Indiates, if output is muted.
e LED lights up red: Mute active.
e LED off: Mute not active.

4.3.2 Overview rear

10

1"

System Ready LED

Indicates the device's system status.

e LED lights up red: system is starting.
e LED lights up green: system is ready.

Input type LED

Indicates the device input status.

* LED lights up green: Analog mode.
e LED lights up red: Digital mode.
Output type LED

Indicates the device output status

e LED lights up green: Analog mode.
e LED lights up red: Digital mode.
Balanced XLR output 2

e Output for analog/digital line signals.
Balanced XLR output 1

e Output for analog line signal only.
Balanced XLR input 2

e Input for analog/digital line signals.
Balanced XLR input 1

¢ Input for analog line signal only.

oA

Rl Ey

NA2-10-DPRO

1/0 Dante™ Interface

€ & C€ Il &

This device complies with part 15 of the FCC. Operation is subject to
the following two conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

www.neutrik.com NEUTRIK

@ @A@Dante/POE® @

SECONDARY /
PRIMARY FEEDTHROUGH

1 Reset Button
* Press to delete all set parameters.
A detailed description see in section "5.5.8
Reset device" on page 32.

2 Link LED
Indicates the Ethernet connection status.
e LED is red: Ethernet connection is
established.
o LED off: no Ethernet connection.

Active LED

Indicates the data transmission status.

e LED flashes green: data transmission
established.

¢ LED off: no data transmission.

Secondary Network connection (RJ45)
Secondary Dante® Interface/Feedthrough/PoE
input (Redundant mode for standalone redundant
purpose, Switched mode for daisy-chaining)

Primary Network connection (RJ45)
Primary Dante® Interface/PoE input

10
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Description of the Product

4.3.3 Modes and switching logic of the DPRO Adapter

Switchable contacts in the DPRO adapter work in 2 ways:
¢ If the signal is analog, connect channel 1 and channel 2 (valid for input and output).
¢ If the signal is AES, connect channel 2 only (valid for input and output).

€) AES carries 2 separate signals over 1 physical cable. Therefore AES is occupying both channels and channel 1 be-
comes inactive. It's not possible to combine an analog signal on channel 1 and AES on channel 2, as this would
mean 3 separate signals are present. In this case channel 1 will have a priority and only the analog signal will be
present. This is valid for input and output.

€) The mode in which the device operates (Analog/AES) is defined by the XLR connections and not by the software
(DPRO Controller). This can lead to a mismatch between device's /O connections and the presets in the DPRO

Controller.

For example:
A preset that includes analog input will not load unless a cable is plugged into input channel 1

A CAUTION
Danger of hearing damage!

Signal peaks may occur as a consequence of incorrect connections.

P Do not connect AES/EBU signal to input 1.
P Do not connect amplifiers or other analog devices to output 2 (AES) if there is no connection on

output 1 (ANA).

User Manual — DANTE™ Adapter NA2-10-DPRO | BDA 573 V4 2020/05 1"



Description of the Product

4.4 DPRO Controller

DPRO Controller allows to control audio parameters, monitor the status of the device, recall, save and load presets. The
app is available for PC and Mac.

4.4.1 General overview

Analog inputs and outputs

Y002-NA2-10-DPRO

DEVICES

Y002-NA2-10-DPRO

INPUT INPUT OUTPUT OUTPUT
CHANNEL 1 Link CHANNEL 2 CHANNEL 1 Link CHANNEL 2

MUTE

Menu

N

Device status
Shows the status of the selected device.

Output settings
Input settings
Link to Dante Controller

Connected devices
The selected device is marked with a green line on the left side.

o Ul bW
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Description of the Product

Menu
File Create Preset Ctrl/Cmd + N
Load Preset Ctrl/Cmd + L
Save As Preset Ctrl/Cmd + S
Quit Windows:
Alt + F4, Ctrl + Q
Mac: Cmd + Q

Device Identify Device Ctrl/Cmd + |

Reset Device
About Device

Network Settings
Firmware Upgrade

Help About Software

Further software functions/shortcuts

Fader Ctrl/Cmd + click on
fader

Device Status

Opens a new Preset window.

Applies created preset to devices.

Saves presets as .dap file on user's computer.
Quits the App.

Identifies the selected device.
The LEDs on the front of the device flash red for 10 seconds.

Deletes all set parameters on the selected device.

Opens a window with general information of the selected
device.

Opens a window with network settings.

Opens a window with firmware information of the selected
device.

e Shows the version of the installed firmware.

e Install firmware upgrade.

Opens a window with general information about the DPRO
Controller app and credits.

Fader jumps to O.

This overview indicates the device status. The description of the LEDs can be found in chapter

"4.3.1 Overview front" on page 9.

DPRO-5E575A97

QO Identify device button

Click on the button to identify the selected device.
LEDs of XLR Inputs and XLR Outputs of the device flash up for 10 seconds.

4% Settings button

Click on the button to open the Settings window.
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Description of the Product

Input Channels

INPUT
CHANNEL 2

INPUT INPUT
CHANNEL 1 ir CHANNEL 2

Analog Inputs AES Inputs: Channel 1 becomes inactive
o[V Microphone/Line Signal button
- LINE Indicates, if the signal has MIC or LINE input sensitivity.
e Click on the button to change the sensitivity.
. LINE Position MIC: Microphone level
Position LINE: Line level
o el Low-cut filter button

Activates the low-cut filter for the input signal.

P Phantom power button (only with MIC signal)
Activate this function if the microphone requires phantom power.

- PAD button
Activate this function to apply 16 dB attenuation.

Link/Unlink button
Click this button to link or unlink the input/output signals.

Gain (only with MIC signal)
@ Adjusts the input sensitivity.
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Description of the Product

Output Channels

OUTPUT
CHANNEL 2

OUTPUT QUTPUT
CHANNEL 1 Link CHANNEL 2

MUTE MUTE

Analog Outputs AES Outputs: Channel 1 becomes inactive

Mute button
Activate to mute the output signal.
- - Link/Unlink button

Click this button to link or unlink the input/output signals.

Meter bar
The Meter bar allows the signal level to be monitored on both input and output.

BLE" m

[ Red area: 0 dBFS to -3 dBFS
-5 2 Yellow area: -3 dBFS to -18 dBFS
E_ 3 Green area: -18 dBFS to infinite

-10

-20

-30

e
NN ACR R R R

4
dBFS

User Manual — DANTE™ Adapter NA2-10-DPRO | BDA 573 V4 2020/05 15



Description of the Product

4.4.2 Create Preset page

With presets, settings of the devices can be stored for a later use. Presets can be also created and stored if no device is
connected or online. After adjusting the parameters, the preset can be saved as .dap file locally on the computer.

e Menu: File > Create Preset

e Shortcut: Ctrl/Cmd + N

Create a new preset

Analog ¥ Analog

INPUT INPUT OUTPUT QUTPUT
CHANNEL 1 Link CHANNEL 2 CHANNEL 1 Link CHANNEL 2

MUTE

Button / Screen text

CANCEL Close the window without saving the preset.
SAVE PRESET Save the preset as .dap file on the computer.
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Description of the Product

4.4.3 Load Preset page

Load a preset from a .dap file from the computer.
e Menu: File > Load Preset
e Shortcut: Ctrl/Cmd + L

Load preset

1 device(s) selected

Select all Select none OUTPUT

=2 ¥ Y002-NA2-10-DPRO ANA  ANA OUTRUT
CHANNEL 1 CHANNEL 2

[l Y007-NA2-10-DPRO

MUTE

PREVIEW

Button / Screen text

Choose devices Select the settings of one or more devices and load as preset.
Select all: Select all devices in the list.
Select none: Select no device in the list.
Checkbox: not selected
Checkbox: selected
PRESET PREVIEW Preview window of the settings which will be loaded with the preset.
CANCEL Close the window without loading the preset.

LOAD PRESET Load preset with the selected device settings.
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Description of the Product

Mismatch

Loading of the preset(s) was not successful. The mode of the preset do not match with device mode (e.g. Preset is saved
with AES mode, device works in analog mode). More information about the modes and switching logic please find in
section "4.3.3 Modes and switching logic of the DPRO Adapter" on page 11.

Load preset

0 device(s) selected =
Preset and device I/0 modes (ANA/AES)
need to match.
OUTPUT

Sele
[ NA
CHANNEL 2

PRESET PREVIEW

I

: Warining lcon.
Indicates a mismatch.
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Description of the Product

4.4.4 Reset Devices window

This function resets the selected devices to factory settings. The reset function is described in section "5.5.8 Reset
device" on page 32.
¢ Menu: Device > Reset Device

¥ Reset Devices X

Reset Devices

¥ DPRO-5E575A97

RESET DEVICES

Button / Screen text

CANCEL Close the window without resetting devices.

RESET DEVICES Reset selected devices to factory settings.
Select all: Select all devices in the list.
Select none: Select no device in the list.
not selected
selected

4.4.5 About Device (Device Settings) window

This window shows general information about the selected device.
¢ Menu: Device > About Device

7 Device Settings X

Device Settings

RESET DEVICE

Button / Screen text

Device name Name of the selected device.

Device Firmware Current Neutrik firmware version installed on the device.

Dante Firmware Current Dante firmware version installed on the device.

IP Address IP address of the device in the network.

FIRMWARE Opens a window to upgrade the Neutrik's firmware on the device.
UPGRADE

RESET DEVICE Reset device to factory settings.
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Description of the Product

4.4.6 Network Settings window

7 Metwork Settings

Network Settings

Static IP Address

‘SET STATIC IP ADDRESS

Button / Screen text

AUTOMATIC
MANUAL

IP Adress

Static IP Address

New Static IP
Address

REBOOT NOW
CANCEL

SET STATIC IP
ADDRESS

The device obtains the IP address from DHCP server or locally from the computer.
The device's IP address can be entered manually.

IP address obtained from DHCP or local computer. Active, if AUTOMATIC is active.
Entered IP address by user. Checked IP address is active.

Enter a new static IP address by clicking the # icon.

Reboots the device.
Close the window without any change.
Set the chosen static IP adress.

4.4.7 Firmware Upgrade window

Upgrade the Neutrik firmware on the device.
e Menu: Device > Firmware Upgrade

5 Firmware Upgrade

Firmware Upgrade
DPRO-5E575A97: Current Firmw; Version

Select Firmware

Button / Screen text

[Device Name]:
Current Firmware
Version X.X

Select Firmware
CANCEL
UPGRADE NOW

Upgrading
Firmware to
Version X.X

Firmware upgrade
completed
sucessfully

7 Firmware Upgrade x

Firmware Upgrade
Y003-NA2-10-DPRO: Current Firmware Version 9.6

Firmware Upgrade
Y003-NA2-10-DPRO: Current Firmware Version 9.6

Upgrading Firmware to Varsion 9.7 Select Firmware

Firmware upgrade completed successfully
Device will now reboot

Information about the current device firmware.

Select the downloaded upgrade file.

Close the window without upgrading firmware.

Install firmware from the selected upgrade file.

Progress bar informs about the firmware upgrade progress.

Information that firmware upgrade is complete. Device will reboot after sucessful upgrade.

20
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4.4.8 About Software window

General information about the app.
¢ Menu: Help > About Software

B Software and Imprint X

Software and Imprint

Button / Screen text

Software Version Version of the DPRO Controller app.
Version Date Release date of the app version.
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5 Operation

5.1 Preparations

P Unpacking the DPRO Adapter.

P> Save packaging for later transport and storage.

P Check the packaging and DPRO Adapter for visible damage.

P When visible damage to the packaging and/or delivered parts is detected:
Contact the salesperson or Neutrik sales partner.

P Do not use damaged devices under any circumstances.

5.2 Connecting devices with the DPRO Adapter

The DPRO Adapter can be connected to a Dante™ network via a standard 1 Gbit/s twisted-pair
Ethernet cable (CAT5e). This connection is responsible for the data transfer as well as for the power
supply. Depending on the cable length and shield, we do not recommend installing cables parallel
to power supply lines. To disconnect DPRO Adapter from power, the PSE or PSE's (switch or injec
tor) have to be disconnected from the power outlet.

The DPRO Adapter requires a Power over Ethernet switch or a PoE injector (802.3 af/
at/bt).

A CAUTION
Danger of hearing damage!

Signal peaks may occur when an audio source or sink is connected.
P Before making connections, mute the signal path of the peripheral devices.

A CAUTION
Danger of hearing damage!

Signal peaks may occur as a consequence of incorrect connections.

P Do not connect AES/EBU signal to input 1.

P Do not connect amplifiers or other analog devices to output 2 (AES) if there is no
connection on output 1 (ANA).

Front Rear

o e @Dante/PoE @ @
CH1 ANA CH2 ANA/AES OUT CH1ANA CH2 ANA/AES

-
[
k
2]
u
2

@
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Operation

» Connect the device depending on the desired application:
Analog signal: Use channel 1 and Channel 2.
AES signal: Use channel 2.
» Connect the DPRO Adapter to the PoE switch using a network cable.
p If the switch does not support PoE:
Use a PoE injector.
+ LEDs light up once the DPRO Adapter is supplied with power via the switch or the PoE injector.
+ The DPRO Adapter is ready for operation.
+ Set up the desired audio connection with the "Dante™ controller" software.

5.2.1 Power setup using a switch with PoE support

PoE switch
ﬁJ_E_tl I DPRO I

PRIMARY

e AUdiO connection
e Network connection

( DANTE
device

I PRIMARY I

AUDIO IN AUDIO OUT

The DPRO Adapter forwards information to the PoE switch indicating that it is a "Class 2"
device to ensure the correct power supply.

5.2.2 Power setup using a switch without PoE support

100/240 V

PRIMARY

Switch with

no PoE support
. DPRO
ﬁ Injector
I PRIMARY I I

f DANTE
device

AUDIO IN AUDIO OUT

For power and data redundancy, use 2x passive PoE injectors. Because they do not use the discov-
ery process, switching between primary and secondary will not result in a short loss of audio. More
information about PoE please find in section "7.2 PoE (Power over Ethernet)" on page 42.

Do not use two different passive PoE injectors (such as from different manufacturers), be-
cause this might cause a short circuit and make the device inoperable.
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5.3 Applications
5.3.1 Redundant Mode
In Redundant mode, two copies of all the Dante™ information (audio, clock etc.) are sent across in
two separate networks to ensure uninterrupted signal flow in case one network goes down.
SECONDARY
PRIMARY | Dante read
mixing des
PoE Injector |l PoE Injector Switch -
ith NO ith NO ith NO
WI1:':Iass WI(Iass P:élsupport l * + + * +
| I I ISECONDARYI
Switch
with NO
PoE support
| PRIMARY
o
= - _I Audio connection
@ Network connection
5.3.2 Switched Mode (Daisy-chained)
In the Switched mode, you can daisy-chain several devices to increase channel count. Only passive
injectors are able to deliver steady power to all the daisy-chained units. Due to safety reasons, when
daisy-chaining, total of 2 devices can be linked, if used with the rubber cover (NA-RC). Total of 4 units
can be linked without the rubber cover (NA-RC) on the devices.
PRIMARY Dante read
I mixing des
PoE Injector Switch -
with with
SECONDARY/ :Ia::o PoEtsu:poort * * + + * +
. FEEDTHROUGH I I I PRIMARY I
PRIMARY
Analog ISECONDARY
mixing desk
I For daisy-chaining, use only a PoE Injector with no
class.
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Linking devices with the Dante™ controller

The Dante™ controller is a free software application that enables routing of audio signals and
configuring devices in a Dante™ network. Setting up a Dante™ network is very easy. The Dante™
controller offers automatic device detection, one-click signal routing and user-editable device and
channel labeling.

The software together with tutorials and guides are available on the Audinate website
(www.audinate.com).

5.3.3 Enabling a Dante™ link

» Download and install the "Dante™ Controller"

software. (www.audinate.com). T : T A
» Connect the computer to the switch using a standard [ s = m " |om==eg
network cable. @Dante o 5 - H B b
"'""'"I:|E 3 g
» Run the "Dante™ Controller" software. —1 ’
P In the routing menu, click the + symbols of the devices. EJ I
> Establish the desired link. o

€) The DPRO Adapter is displayed in the "Dan-
te™ Controller" as a NA2DPRO by default, followed
by a suffix with the last 6 digits of the MAC ad-
dress. This name can be customized for each device
in the Dante™ controller.

The "Dante™ Controller" software is used only to set up the audio connection (routing) between
devices and to configure the subscribing devices.
The devices are controlled in the DPRO Controller App.

5.4 DPRO Controller App

DPRO Controller allows user to control audio parameters, monitor the status of the device, recall,
save and load presets. The app is available for PC and Mac.

€ Install Dante® Controller from Audinate first before using NA2-10-DPRO within DPRO
controller.

5.4.1 Downloading and installing DPRO Controller App

DPRO Controller App is available for PC and Mac, free of charge.
Please review the system requirements in the technical data before installing the app.

» Download the app on the Neutrik website: www.neutrik.com/en/support/downloads.
Installation on Windows

P> Execute the downloaded .exe file and follow the installation steps.
« The installation wizard creates an entry in Start menu and a link on your Desktop.

DPRO Controller
Installation on OS X app icon
P> Execute the downloaded .dmg file and follow the installation steps.
« The DPRO Controller App is installed on computer.
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5.4.2 Connecting devices with the app
P Connect the devices as required.

P> Start up the DPRO Controller.
« The devices are connected with DPRO Controller automatically.

5.4.3 Selecting the device to edit

Y002-NA2-10-DPRO

DEVICES

Y002-NA2-10-DPRO

INPUT INPUT OUTPUT OUTPUT
CHANNEL 1 7 CHANNEL 2 CHANNEL 1 ink CHANNEL 2

MUTE

P In the connected devices list (1), click on the device name.
+ The selected device is marked with a green line on the left side.

5.4.4 Setting input parameters

7 P Change MIC/LINE:
INPUT INPUT .
CHANNEL 1 CHANNEL 2 Click the MIC/LINE button.
P Activate/deactivate the -16 dB attenuator:
Click the PAD button.
P Activate/deactivate the low-cut filter:

o Click the 80Hz button.
P Activate/deactivate phantom power:
PAD Click the +48V button.

P Adjust gain:

Click and hold the gain knob and move the mouse.
P Link/unlink input channels

Click the Link/Unlink button.

26 User Manual — DANTE™ Adapter NA2-10-DPRO | BDA 573 V4 2020/05



Operation

5.4.5 Setting output parameters

» Mute/unmute channel:

OUTPUT OuUTPUT
CHANNEL 1 niin} CHANNEL 2 Click the MUTE button.
» Adjust output volume:
il Click and hold the fader button and move the mouse up or
down.

» Jump fader to O:
Hold Ctrl/Cmd and click on the fader.
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5.4.6 Presets
Presets allow user to save the settings of the devices that are connected to the app.
Create preset

P Click in the menu File > Create Preset... or use the shortcut Ctrl/Cmd + N.
« The Create a new preset window appears.

Create a new preset

Analog > Analog

INPUT INPUT ouTPUT QuUTPUT
CHANNEL 1 Link CHANNEL 2 CHANNEL 1 Link CHANNEL 2

MUTE

P In the drop down menu, select the Input Mode and the Output Mode (None, Analog, AES)
depending on your application.

» Set your parameters.

» Click the SAVE PRESET button to save the preset as .dap file on your computer.
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Load Preset
P Click in the menu File > Load Preset... or use the shortcut or Ctrl/Cmd + L.

& Please choose a preset x

T~ » ThisPC > Desktop » DPRO Presets v | & | Search DPRO Presets P

Organize * Mew folder =~ M @

5 This pC A Name Date modified Type Size

2D Objects | ] ANA IN_AES OUT.dap
[ Desktop | ANAIN_OUT.dap
[ Documents
& Downloads
B Music
=] Pictures
B videos
2 Windows (C)
= opticalCON (G)

0:40 DAP File TKB
)15 14:06 DAP File TKE

= Intranet (I}

= SAP (M)

= Home (P})

= Ablage (Q)

== Produktion (R1 Y

File name: | | |oPRO presets ¢ dap) v

P> Select a .dap file on your computer and click the Open button.
« The Load preset window appears, which shows a preview of the preset to be loaded.

Load preset

1 device(s) selected

Select all Select none OUTPUT

gt ¥ Y002-NA2-10-DPRO ANA ANA HHEEL
CHANNEL 1 CHANNEL 2

[l YO07-NA2-10-DPRO ANZ ANA

» In the drop down menu, select your devices.
P Check if the connected input/output signals matches with the preset modes (ANA/AES).
P To load the preset, click the LOAD PRESET button.
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v If Load Preset was not sucessful, the Load Preset mismatch screen appears.

Load preset

0 device(s) selected

Select all Select none OUTPUT
ANA A OUTPUT
CHANNEL 2

P Check the device's input/output connections:
For analog signal use channel 1 and channel 2.
For AES signal use channel 2.
P Try to load the preset again or load another preset.
P If no matching preset is available, create a new preset.

More information about the modes and switching logic please find in section "4.3.3 Modes
and switching logic of the DPRO Adapter" on page 11.
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Save Preset

P Click in the menu File > Save As Preset... or use the shortcut Ctrl/Cmd + S.

@ savePreset As
T > ThisPC > Desktop > DPRO Presets

Organize ¥ Mew folder

B This PC MName Date medified

J 3D Objects [7] ANA IN_AES OUT.dap
[ Desktop

=| Documents
J Downloads

D Music

=] Pictures
B videos
S Windows (C)
= opticalCON (G:)
= Intranet (1)

= SAP (M)

= Home (P:) v

Type

DAP File

File name: ||

Save as type: | DPRO presets (*.dap)

~ Hide Folders

» Enter a file name and click the Save button.

5.4.7 Identify device
P> Select the device to identify.
Option 1:

P Click in the menu Device > Identify Device.
Option 2:

» Click the device status overview the identify device button Q..

Option 3:
P Use the shortcut Ctrl/Cmd + .

+ The LEDs of the device flash up for 10 seconds.
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5.4.8 Reset device

This option deletes all set parameters on the selected device. The device remains connected to the
app. There are two ways to reset the device.

Hardware reset

The hardware reset resets the following parameters:
e If MIC is active: Gain = 0 dB, HPF and Phantom power will be off.
e Network settings: Reset to Factory default (DHCP enabled).
¢ Outputs Mute will be off.
L]

@ @a@Dante€/PoE @ @

Rﬁzy
NA2-10-DPRO

1/0 Dante™ Interface

€ & C€ Hl 2

This device complies with part 15 of the FCC. Operation is subject to
the following two conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

www.neutrik.com INNEUTRIK PRIMARY FSEi%?—HESS\él/-l

P On the back of the device, push the RESET button (1) for approx. 5 seconds.
« Device is reset.

Software reset

The software reset resets the following parameters:

e If MIC is active: Gain = 0 dB, HPF and Phantom power will be off.
e Network settings: Reset to Factory default (DHCP enabled).

¢ Outputs Mute will be off.

P Click in the menu Device > Reset Device. ...
« The Reset Devices window appears.

B Reset Devices X

Reset Devices

¥ DPRO-5E575A97

P> Select the devices you want to reset.
P Click the RESET DEVICES button.
« The devices are reset.

32 User Manual — DANTE™ Adapter NA2-10-DPRO | BDA 573 V4 2020/05



Operation

5.4.9 Network Settings
The internal IP address can be set in 2 modes.

Automatic
The device obtains the IP address from DHCP server or locally from the computer.

7 Network Settings X

Network Settings avromanc @)

Manual
The user defines the IP address manually.

7 Network Settings X

Network Settings

Static IP Address

P Choose the MANUAL mode.
« A new line to enter New Static IP Address appears.
» Click the # icon to enter the static IP address.
P Click the SET STATIC IP ADDRESS button.
P Reboot the device:
Click the REBOOT NOW button.
« The static IP address is assigned to the device.
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5.4.10 Firmware Upgrade
With the Firmware Upgrade function in the DPRO Controller app user can only upgrade the
Neutrik's firmware of the device. To upgrade the Dante™ Firmware, please use the Dante™
controller
P Download the Firmware Upgrade on the Neutrik website:
www.neutrik.com/en/support/downloads.
P In the DPRO Controller app, select the device to upgrade.
Option 1:
P Click in the menu Device > Firmware Upgrade.
Option 2:
> Click the device status overview the device settings button 4.
+ The Device Settings window appears.
B Device Settings X
Device Settings
P Click the FIRMWARE UPGRADE button.
+ The Firmware Upgrade window appears.
B Firmware Upgrade X
Firmware Upgrade
P> Click the Choose... button and select the downloaded upgrade file.
P Click the UPGRADE NOW button.
+ The device's firmware upgrade will be installed.
5 Firmware Upgrade * 5 Firmware Upgrade *
Firmware Upgrade Firmware Upgrade
v During the upgrade the progress bar shows the upgrade progress.
v If the upgrade is completed, the message Firmware upgrade completed successfully appears.
+ The device starts rebooting.
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5.5 Accessories assembly instructions

A NOTE

Use only original Neutrik screws to prevent damage to the device.

5.5.1 Mounting brackets

The mounting brackets make it possible to mount the device in floor boxes, underneath tables, etc.

Scope of delivery
Assembly of the mounting brackets

Prepare the following tools:
& Torx Screwdriver (T10)

2 brackets

BR o0 .. .

2 fixing screws

2 torx screws 2 spacers

P Remove the rubber protection.

» Mount the fixing screw as shown on the picture.
P> Repeat these steps on the opposite side of the device.

» Mount a bracket, a spacer and a screw on the device as
shown on the picture.

P Tighten the screw with the scewdriver.

P> Repeat these steps on the opposite side of the device.

N2 @Dania /POl

a8 o8

P Turn the brackets as required for the mounting
situation.
P Tighten the fixing screw firmly.
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5.5.2 Rack panel

Scope of delivery

1 rack panel

Assembling the rack panel

Prepare the following tools:
& Crosshead screwdriver

INt  Line IN2 BDante /PoE OUT1 Line OUT2

—

P Remove the rubber protection. P Remove the 4 screws on the front of the device.

N 'o.ui

P> Place the device in the rack panel.
P Fix the device with the four screws.
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5.5.3 Trussmount
Assembling the trussmount
The mounting make it possible to mount the device in floor boxes, underneath tables, etc.

Scope of delivery
Assembly of the kit

Prepare the following tools:
& Crosshead screwdriver

P99 w "

4 Crosshead screws 4 fixing screws 2 Safety Frame 1 Yoke Mount

1 ﬁ

2

P Use the existing installed screws (4 pcs. M3 x 6 mm).
P> Place the safety frame onto the device and tigthen it.

P> Fix the device with the fixing screw.
P Position the screw.
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6 After Operation

6.1 Dismounting devices

P Disconnect devices from audio sources/sinks.

6.2 Transporting

P Always transport devices and accessories in their original packaging.

6.3 Storage

P> If devices are not used for a longer period:
Disconnect the device from the connected devices.
P Always store devices in a clean, dry location.
P Always protect devices from dirt, dust, heat, humidity and moisture.

6.4 Cleaning and care

Danger of property damage due to improper cleaning!

P Disconnect device from all connections before cleaning.
P> Never immerse device or accessory in water under any circumstances.
P Never spray device or accessory with liquids under any circumstances.

P Wipe the surfaces of the device and accessory with a soft cloth slightly moistened with a mild
soap solution.

P Never use aggressive, solvent-based or abrasive cleaning agents under any circumstances.

P Never use rough materials (e.g., cleaning cloths or sponges with a rough coating).

6.5 Maintenance and repair

The DPRO Adapter does not contain any parts that can be maintained or repaired by the user.
P Only have the DPRO Adapter repaired by a specialist dealer authorized by Neutrik.

P Check the DPRO Adapter regularly for visible damage to the housings, controls, connections,
cables and plugs.

» If damage is detected, do not use device under any circumstances.

» Immediately decommission the damaged device.

P> Replace defective cables or accessories immediately.

38 User Manual — DANTE™ Adapter NA2-10-DPRO | BDA 573 V4 2020/05



After Operation

6.6 Disposal

regulations.
P> Never dispose of electrical devices or electrical accessories such as cables, plugs,
batteries or components with household wastes under any circumstances.

ﬁ P> Dispose of the DPRO Adapter and accessories in accordance with the applicable local

P> Dispose of packaging and packaging elements in accordance with the applicable local
regulations.

P> Take device components made of plastic, metal or other recyclables for reclamation in
accordance with the applicable local regulations.
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7 Appendix

7.1 Technical specifications

Dante™ specifications

Channels 2 INPUTS (Line Level / Mic / AES / EBU)

2 OUTPUTS (Line Level / Mic / AES / EBU)
Supported sampling rates 44.1/48/88.2 /96 kHz
Bit depth 16, 24 and 32 Bit
Latency based on user selection 0,25 ms (Dante)
Ethernet connection 1.000 BASE-T (supporting PoE)

Electrical specifications
Power consumption < 6 watts

Power supply 1.000 BASE-T (supporting PoE) or
PoE injector (according to IEEE 802.3af/at/bt)

Analog audio input

Equivalent input noise -128 dBu (67 dB Gain); A-weighted
Gain hub (3 dB Steps) 0-67dB
Max. input level +24 dBu (PAD enabled)
+8 dBu (PAD disabled)
Input impedance > 7.5 kOhm, balanced
Frequency response 20 Hz to 20 kHz (£ 0.5 dB)
Dynamic range > 112 dB, BW 22.4 kHz, A-weighted (input gain = min.)
Signal-to-noise ratio > 112 dB, BW 22.4 kHz, A-weighted
THD + noise < 0.005 % (20 Hz to 20 kHz, +4 dBu)
Crosstalk -100 dB, adjacent INPUT/OUTPUT channels (input gain = min.)

Analog audio output

Output impedance < 150 Ohm, balanced

Max. output level +24 dBu

Residual output noise -88 dBu, A-weighted

Frequency response 20 Hz to 20 kHz (£ 0.5 dB)

Dynamic range > 112 dB, BW 22.4kHz, A-weighted

Signal-to-noise ratio > 112 dB, BW 22.4kHz, A-weighted

THD + noise < 0.005% (20 Hz to 20 kHz, +4 dBu)

Crosstalk -100dB, adjacent INPUT/OUTPUT channels (input gain = min.)
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Mechanical specifications

Weight

Dimensions
(with rubber protection)

Dimensions
(without rubber protection)

Operating environment
Operating temperature
Storage temperature

0.53kg/ 1.17 lbs

L =164 mm (6.4 inches)
B = 82 mm (3.2 inches)
H =51 mm (2.0 inches)

L =151 mm (5.9 inches)
B = 66 mm (2.6 inches)
H =41 mm (1.6 inches)

Indoor

0 °C to +50 °C
—-40 °C to +70 °C

App Requirements
RAM

Display resolution
Operating System

7.1.1 Phase behaviour

min. 2 GB

min. 1280 x 1024 px

Windows 7 or later
MAC OS X 10.12 or higher

All NA2-10-DPRO devices from SN 830000 to SN 831294 have an inverted polarity both on the input side and on the

output side due to the use of an inverting amplifier.

Both between analog IN --> DANTE digital audio and DANTE digital audio --> analog OUT the polarity is inverted.

hot——>
g- —nhot (inverted)—>
©
. (o)}
Input side ground-> £
(9]
>
£ —cold (inverted)—>
cold————>
hot > g—
A ©
Output side DANTE @
output b=
g
cold—> =

DANTE
input

—hot (inverted)

——ground

—cold (inverted

The inverting of the signal does not have any impact to the audio quality or timing!
However, if this is a problem in a specific application, please contact your local Neutrik dealer.
Neutrik will offer a reasonable solution for customers.
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7.2 PoE (Power over Ethernet)

PoE stands for Power over Ethernet and describes a practice for using a single CAT5e (or higher) to
incorporate both power and data in the single cable.

Few advantages:

e Easy setup

¢ Single cable run up to 100 m

¢ Using PoE doesn’t require certified electrician as the power loads are small
« Existing network infrastructure can be used

7.2.1 Definitions

PD (Powered device) — device that is connected to PSE and thus is powered by it.
PSE (Power Sourcing Equipment) — device that provides power to PD, can be a network switch or
injector.

PSE Types

In our case, we consider only following two types of PSE devices.

e PoE Switch: a switch that offers possibility to power PD. Switches use PoE
classification.

¢ PoE Injector: typically a single port device for powering 1 PD. These exist with
classification (active) or without (passive). Neutrik's NPS-30W is a passive PoE injector.

The term class refers to a maximal power output (see table below).

7.2.2 PoE Standards

These standards are part of IEEE 802.3 general standards.

802.3 af — defines PoE classes 0-3.

802.3 at — uses the same classes, but introduces class 4 as well.

802.3 bt — uses the same classes as 802.3 af and 802.3 at, but introduces class 5 to 8 as well.

7.2.3 Classes and discovery process

Discovery is a process of PSE, determining the power requirements of the PD. Once PD and PSE are
connected, PSE sends out a short voltage impulse, reads the returned value and provides power
accordingly. This is valid for PSE with class (also called active).

No class (passive) PSE, acts as a classic power supply, hence no discovery is implemented, and PSE
supplies deliver current at all times.

|EEE 802.3af 0.44-384 W
3.84-6.49 W
6.49 - 1295 W
IEEE 802.3at 12.95-255W
IEEE 802.3bt 255-40W
40 -51W
51-62 W
62-73W

0 N o Ul A WN =
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